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De Designer software is opgebouwd uit allemaal panelen welke ‘windows’ genoemd worden, deze windows 
zijn vrij is te stellen. Er kan gewerkt worden met tabbladen. Deze windows zijn ook weer af te sluiten door op 
de X te drukken.

De windows kunnen ingedeeld worden door ze op een andere plek op het scherm te slepen. 

Sommige windows worden verticaal zichtbaar aan de linker of rechterzijde van het scherm. 

Weer andere worden als een nieuw tabblad zichtbaar.

De instelling zijn te resetten via Window -> Reset Pane Positions

1. DESIGNER OPBOUW
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2. IP-CONFIGURATIE

Om verbinding te kunnen maken met het Helvar systeem moet eerst uitgelezen worden in welke IP-reeks het 
systeem zit om de laptop te kunnen verbinden.

A. UITLEZEN HUIDIGE IP-ADRESSEN ROUTERS
Stap 1:
- Open Designer 

Stap 2:
- In het tabblad Routers staat een overzicht van alle aangesloten routers op het netwerk.
- Hierin staan de IP-adressen van de routers weergegeven

B. IP CONFIGURATIE LAPTOP/PC
Stap 1:
- Ga via Start naar Configuratiescherm en kies Netwerkcentrum

Stap 2:
- Klik in het linker menu op Adapterinstellingen wijzigen.
- In dit menu is het mogelijk de instellingen van uw netwerkpoorten in te stellen.

Stap 3:
- Dubbelklik op de verbinding waarop de routers zijn aangesloten

Gebruik alleen een bekabelde verbinding voor programmeerwerkzaamheden waarbij de Firewall het beste 
uitgezet kan worden.

Bij S/W Version is te zien op welke 
softwareversie de routers draaien.
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Stap 4: 
- Klik op Eigenschappen

Stap 5: 
- Selecteer Internet Protocol versie 4(TCP/IP4) en  
 klik op Eigenschappen.

Stap 6:
- Kies: Het volgende IP- adres gebruiken
- Pas het IP-adres en het Subnetmask aan binnen de reeks van de routers

Stap 7:
- Klik op OK en sluit alle vensters

Stap 8:
- Herstart Designer om alle netwerkwijzigingen door te voeren
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3. INSTELLEN VAN ROUTERS EN INLOGGEN

Het instellen van routers moet gebeuren voordat er een project geprogrammeerd wordt. Eventuele wijzigin-
gen aan IP-adressen in reeds geprogrammeerde routers kan voor storingen aan een werkend systeem 
zorgen.

A. WIJZIGINGEN VAN ROUTER-EIGENSCHAPPEN
Stap 1:
- Verander de Usermode naar Advanced  

Stap 2:
- Klik op één of meerdere routers in het tabblad Routers en ga naar het tabblad Properties
- Onder View in de menubalk zijn de Properties weer te openen

Stap 3:
- Wijzig de gegevens van de router(s)

Stap 4:
- Bevestig de wijzigingen door te bevestigen met . Hierna zullen de routers herstarten

Stap 5: 
- Wacht tot de routers weer terugkomen in het tabblad Routers en controleer de wijzigingen

Bij identieke benaming van de workgroup vormt zich één project. Als er een afwijking in deze benaming zit 
worden er twee of meerdere projecten gecreëerd.
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B. INLOGGEN OP DE WORKGROUP
Stap 1:
- Klik op Go Online   

Stap 2: 
- Kies de juiste Workgroup
- Kies de juiste Network Interface

Stap 3:
- Let op of de onderstaande twee afbeeldingen onder in het scherm netjes doorlopen. Als dit niet gebeurt is  
 er waarschijnlijk iets mis met de IP-instellingen.

C. UPDATEN ROUTERS
Stap 1:
- Open het tabblad Routers

Stap 2:
- Verander de Usermode naar Pro  

Stap 3: 
- Rechter muisklik op een router > Update Software

Stap 4:
- Vul het wachtwoord hydrogen1066 in en druk op OK.   

Stap 5:
- Klik op de te updaten router(s) en vervolgens op Update.

Stap 6:
- Wacht tot de router herstart is (de router zal tijdelijk uit het venster verdwijnen) en druk daarna op Close

Door Synchronise Time aan te vinken wordt de tijd 
van de laptop/pc overgezet op de routers binnen de 
workgroup
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4. COMPONENTEN OVERVIEW EN RAPPORTAGE

Bij de eerste inlog worden alleen de componenten weer gegeven die online zijn. Bij het inloggen op een 
bestaand systeem kunnen er ook foutmeldingen op de reeds geprogrammeerde armaturen zichtbaar zijn.

A. OVERVIEW VAN DE AANGESLOTEN COMPONENTEN
Stap 1: 
- Open het Devices tabblad

Stap 2: 
- Klik op de + tekens om de boomstructuur te openen. Devices zijn niet te verwijderen zolang ze online zijn

Storingen of meldingen worden voor de componenten weergegeven met de volgende symbolen:
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Naast het uitlezen van de huidige status via de Device-tree zijn er meerdere mogelijkheden om een rap-
portage uit te draaien van de huidige status van het systeem.

B. RAPPORTAGE
Stap 1:
	- Via Tools in de menubalk zijn er diverse rapportages te genereren:	

	- System Diagnostics Report voor alle foutmeldingen binnen het systeem         
	- Grouping Report om alle gegevens per groep te zien
	- Device Report voor alle aangesloten componenten
	- Emergency Report voor de rapportage van de noodverlichting

Stap 2: 
	- Open het tabblad Reports, aan de linkerzijde naast Devices	   	               
	- Door op  te klikken blijft hij in beeld  

Stap 3:
	- Rechter muisknop op één van de reports geeft de mogelijkheid om op te slaan

C. POLLING DALI-LIJN UITLEZEN
Stap 1:
	- Open het Devices tabblad

Stap 2:
	- Kies de DALI-lijn (DALI Subnet) waar de									       

	 polling van uitgelezen moet worden.

Stap 3:
-  Rechter muisklik -> History

Stap 4:
	- Bekijk de gewenste gegevens in het nieuw geopende tabblad   

Stap 5:
	- Pauzeren, opslaan en leeg maken kan aan de linkerzijde van dit venster    

D. EVENT LOG
Stap 1:
	- Open in menubalk View de Event log

Stap 2:
	- In het geopende tabblad zijn alle acties in het systeem uit te lezen

Stap 3:
	- Pauzeren, opslaan en leeg maken kan aan de linkerzijde van dit venster    
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E. AUTOMATISCH OPSLAAN LOGFILES
Stap 1:
	- Open de Options onder menu Tools

Stap 2:
	- Verander de ‘Logging to window only’ velden naar ‘Logging to window and file’

Stap 3:
	- In de bovengenoemde ‘path’ zal nu een map staan, hierin worden de logfiles in .CSV formaat geplaatst

Stap 4:
	- Klik op Ok
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5. IDENTIFICEREN, HERNOEMEN EN ADRES WIJZIGEN

In de Workgroup verschijnt een lijst met alle aangesloten 
componenten. In de volgende stap dienen alle componenten 
geïdentificeerd te worden zodat u weet waar alle armaturen, 
sensoren etc. zich bevinden.

Gebruik een plattegrond met aanduiding voor sensoren en 
armaturen.

A. IDENTIFICEREN
Stap 1:
- Kies in de menubalk View Identify of druk op F3

Stap 2:
- Selecteer een component in het Devices scherm. Er worden verschillende mogelijkheden gegeven om te  
 identificeren
            

Stap 3:
- Klik op Toggle or Flash

Voor een DALI-router:
-  De status leds beginnen te knipperen
Voor een DALI-subnet:
-  Alle componenten die correct functioneren beginnen te knipperen
Voor een LED-Driver:
-  Enkel dit component knippert

Zolang het Identify-tabblad geopend is blijft de functie actief. Door het tabblad te sluiten wordt ook de 
Identify functie afgesloten
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B. HERNOEMEN
Probeer zoveel mogelijk nuttige informatie in de benaming te zetten, denk aan ruimtenummers, raam of 
gangkant enz. Dit maakt de vervolgstappen eenvoudiger.

Stap 1:
- Druk op F3 om te identificeren

Stap 2:
- Druk op F2 om de naam van het device te wijzigen

Stap 3:
- Wijzig de naam en druk op Enter

Stap 4:
- Sluit het Identify tabblad om onnodig knipperen van de verlichting te voorkomen

C. ADRES WIJZIGEN
Er is geen logische volgorde in de adressering. De DALI-routers zullen de eerste keer bij het opstarten een 
willekeurig adres toewijzen aan de componenten. Voor uitgangen (LED drivers, dimmers, rolluiksturingen,…) 
zullen zij telkens starten vanaf adres 1 en dit laten oplopen. Voor inputs (bedieningspanelen, sensoren) zullen 
zij telkens starten bij 63 en aftellen. De adress worden weergegeven met het @ nummer achter het device.  
Adres 64 wordt enkel gebruikt als de bus vol is. De adressen zijn aanpasbaar.

Stap 1:
- Klik met de rechtermuisknop op het device. Druk op Change Device Address om het adres te wijzigen,    
 hiervoor kunt u ook F8 gebruiken

Stap 2:
- Vul in de pop-up het nieuwe adres in, en klik op ok.            

Herhaal stap 1 en 2 tot de gewenste volgorde is bereikt



Helvar | Lighting Controls B.V.
Handleiding Designer software 13

6. GROEPEN

Helvar Designer werkt op basis van groepen, blocks en scenes. Er kunnen maximaal 65.536 groepen 
gemaakt worden, elk bestaande uit 8 blocks van 16 scenes.

Diverse onderdelen in de software functioneren alleen binnen een bepaald block. Ook voor feedback is het 
noodzakelijk om alle schakelingen in hetzelfde block uit te laten voeren.

Iedere groep krijgt een groepsnummer en naam. Het is aan te raden om een logische groepsnummering te 
gebruiken. 

A. GROEPEN AANMAKEN
Stap 1:
	- Zorg dat de Usermode op Advanced staat 

Stap 2:
	- Open in menubalk View de Groups of klik op 

Stap 3:
	- Druk op + om een groep toe te voegen, en vul de juiste naam en nummer in. Laat altijd het groepsnummer 	

	 in de naam staan! Zo is makkelijk uit te lezen om welk nummer het gaat. 

Stap 4:
	- Door dubbel te klikken op een groep is te zien wat er in deze groep zit aan devices en routing entries

Bijvoorbeeld: Het klaslokaal bevindt zich op de 1ste verdieping. Het lokaal nummer is 2. Een mogelijk 
groepsnummer zou dus 12 kunnen zijn. Om de nummering nog specifieker te maken zou hier nog een 0 
aan toegevoegd kunnen worden. Dan wordt het groepsnummer 120 de groep met alle armaturen in dit 
lokaal. 121 de groep armaturen aan de raamzijde en groep 122 de armaturen aan de kant van het bord. 
Indien er minder dan 9 lokalen per verdieping zijn zou dit correct zijn. Als er meer lokalen zijn is het beter 
om groep 1020 te gebruiken. Dus 1 staat dan voor verdieping, 02 voor het lokaalnummer en 0 voor een 
onderverdeling. 
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B. DEVICES TOEVOEGEN AAN GROEPEN
Stap 1:
	- Selecteer één of meerdere devices

Stap 2:
	- Ga naar de Properties, deze kan altijd geopend worden door rechtermuisklik -> 	

	 Properties

Stap 3:
	- Bij Groups onder Groups staan nu de groepen aangegeven waar het device in zit

Stap 4:
	- Append by Number voor het toevoegen van een groep
	- Append by Name voor het toevoegen van een groep op basis van benaming

Stap 5:
	- Een groep is eenvoudig te verwijderen door hem te verwijderen bij Groups

Stap 6:
	- Devices kunnen ook door 'Drag & Drop' aan een groep toegevoegd worden, 		

	 sleep hiervoor de devices naar de groep in het Groups venster

C. SCENE TABLE 
Elke schakelaar, sensor, storingsmelding, feedback, zonweringsmodule, enz. werkt op basis van instellingen 
per scene. In de Scene table zijn de instelling van de componenten per scene aan te passen.

Er zijn 8 blokken van elk 16 scènes. Bepaalde instellingen werken alleen maar binnen een bepaald blok, een 
voorbeeld hiervan is bijvoorbeeld de bewegingsmelder. In hoofdstuk 8E wordt deze beschreven.

Stap 1:
	- Open in menubalk View de Scene Table of klik op 

Stap 2:
	- Klik aan de linker bovenzijde op 

Stap 3:
	- Selecteer de juiste groep. In het Scene Table scherm zie je nu de armaturen van deze groep verticaal.
	- Horizontaal staan de waardes van de armaturen weergegeven bij de te kiezen scene
	- L staat voor last level en * voor ignore. Hierbij zal er geen actie uitgevoerd worden.

Stap 4:
	- Pas hier eventueel de waardes aan door op een vak te klikken en de waarde aan te passen. 
	- Kopiëren en plakken is mogelijk met de volgende knoppen 

Zie ‘Scene Table’ in de F1 helpfile voor meer informatie
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Stap 5:
	- Bevestigen met Ok

Stap 6:
	- De instelling zijn te testen door op  voor de scene te klikken. Hiervoor moet het bliksemschicht aan 		

	 staan 

D. TESTEN EN AANSTUREN SCENES
Het is ook mogelijk om vanaf de laptop de scenes aan te sturen. Zo kunnen de instellingen gelijk geactiveerd 
worden.

Stap 1: 
	- Zorg ervoor dat de bliksemschicht geactiveerd is, je bent nu dus Live

Stap 2: 
	- Klik op de Go To button in de menubalk

Stap 3:
	- Het bovenste venster in de pop-up kan leeg blijven
	- Vul in het onderste veld de aan te sturen scene in, doe dat in deze notatie:  ‘Group.Block.Scene’. 		

	 Bijvoorbeeld 1418.1.13 om group 1418 naar scene 13 te sturen.

Stap 4:
	- Vink de bovenste regel aan om ook de eventuele routing entries hierbij te activeren, bijvoorbeeld om 		

	 aanwezige linken mee te activeren
	- Vink de onderste regel aan om ook de Constant Light te activeren. Als deze niet geactiveerd is zal alleen 	

	 de gekozen scene aangestuurd worden.

Stap 5:
	- Druk Go om te sturen, en Close om af te sluiten

Als deze bliksemschicht aanstaat betekent het dat je Live bent. Hierdoor zal elke wijziging die je doet, 
elke bediening die je test, en elke actie die je genereert gelijk in het systeem uitgevoerd worden. Als de 
bliksemschicht uit staat zal dit bij het eerstvolgende schakelmoment uitgevoerd worden.
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7. BEDIENINGEN

Om bedieningen te gebruiken moeten deze steeds gekoppeld worden aan een groep > blok > scene. 
Deze 3 parameters zijn dus steeds nodig. Deze kan u instellen in het properties scherm van de door u, 
in de boomstructuur gekozen bediening. Elke DALI Helvar bediening heeft de keuze uit verschillende 
werkmethodes. Deze kunnen ingesteld worden in de bedieningselementen van de schakelaars in de 
boomstructuur in het Devices scherm.

Bij iedere bediening wordt dezelfde actie uitgevoerd

Short Press: Actie bij korte bediening
Long Press: Actie na 10 seconden 

Short press:  direct last level
Long press:  na 10 seconden set scene 2

Eerste druk: On function 1

Tweede druk: On function 2

Derde druk: Off function 

Werkt altijd in een loop
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Short Press / step: voor enkel op/dim

Continuous Function: bij inhouden
Op/neer dimmen

Eerste druk: On Function 1

Tweede druk: Off Function 2
Continuous: bij indrukken op/neer dimmen

Maakcontact (closing)

Verbreekcontact (opening)

Deze is alleen te selecteren bij een inputmodule. Hij stuurt 
de actie bij het maken of verbreken van een extern contact
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A. INSTELLEN BEDIENINGEN
Stap 1:
	- Ga in het scherm Devices naar één van de bedieningen of inputmodules         

Stap 2:
	- Klik op de + voor het device om de afzonderlijke knoppen te zien
	- Elke knop is afzonderlijk te programmeren. 

Stap 3:
	- Ga naar Properties en stel de juiste waardes in
	- Werk altijd met Recall Scene, alleen op deze manier houdt je de juiste feedback
	- Pas eventueel de fadetijd aan

Stap 4:
	- Bevestig met Ok

B. TESTEN BEDIENINGEN
Stap 1:
	- Dubbel klik op de Button in het device scherm   

Stap 2:
	- Door op de pop-up te drukken zijn de instellingen te testen                               

C.  FADE TIME
Fadetijd is de tijd dat de verlichting dimmend aan of uit gaat. De minimale tijd is 0 seconde en de maximale 
tijd is 90 seconden.

Let ook op de ‘out of the box’ instellingen. De scenes zijn al standaard ingesteld

Als de bliksemschicht aan staat zal deze actie ook live gebeuren. Als de bliksemschicht uit staat is de 
schakeling via het Event Log scherm te bekijken. Deze Event Log is terug te vinden onder menubalk View.

Out of the box staat alles ingesteld op 2 seconden.
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Via Routing Entries zijn we in staat om een complexere programmering te maken. Een Routing Entry is een 
functieblok dat is ingebouwd in de software.

Stap 1:
	- Open het tabblad Routing Entries, of open het via menu View of 

    

Stap 2:
	- Klik met rechter muisknop in het tabblad om een Routing Entry toe te voegen

 

A. ALGEMENE TERMEN
Allow Further Routing
Mag het systeem na de Action van de Routing Entries nog de daarbij behorende en eventuele linken verder 
vervolgen? 	

Condition
Standaard Always of Never, maar uit de breiden door het maken van eigen condities (dit wordt in een later 
hoofdstuk omschreven). Denk bijvoorbeeld aan een glaszenwasschakelaar: een conditie aan de down knop 
van zonweringsbediening met de conditie dat hij dit alleen mag doen zolang de glazenwasschakelaar niet 
actief is.

De laatste kolom ‘State’ laat de status van de routing entries zien. Hierin zijn de actieve linken en tijden te 
zien. Ook zijn hier lichtwaardes uit te lezen.

De twee lichtgrijze regels staan er om de sensoren ‘out 
of the box’ al te laten functioneren, deze kunnen niet 
verwijderd worden.

8. ROUTING ENTRIES
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B. SCENE CONDITION
Deze functie maakt het mogelijk om een scene aan te roepen bij het opstarten van een router.

Stap 1:
	- Voeg in het tabblad Routing Entries een Scene Condition toe  

	 Rechtermuis > Insert

Stap 2:
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te 	

	 maken
	- Geef een duidelijke naam op, beginnende met SC wat voor Scene Condition staat
	- Zet 'Called at Power-up' op True

Stap 3:
	- Kies bij de trigger welke actie uitgevoerd moet worden.

C. REDIRECTS
Deze functie maakt het mogelijk om gegevens direct door te sturen tussen groepen.

De Redirects zijn onderverdeeld in 3 delen:
Scene Redirect:	door een scene te triggeren wordt er direct een andere scene mee geactiveerd 
Block Redirect: door het triggeren van één van de scenes in een block activeert deze dezelfde scene in een 
ander block en Group
Group Redirect:	Zet alle gegevens van de ene Group over naar de andere Group, ook dimwaardes en 
lichtwaardes worden over gezet

Stap 1:
	- Voeg in het tabblad Routing Entries een Redirect toe 

	 Rechtermuis > Insert

Stap 2:
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te 	

	 maken
	- Geef een duidelijke naam op, beginnende met SR, BR of GR wat voor Scene, Block of Group Redirect staat

Stap 3:
	- ‘Enable LED Tellback’ kan op True gezet worden om ook de feedback van de trigger groep over te zetten. 	

	 Als deze op False staat blijft de feedback staan en zet hij alles alleen door naar de Action Group

Stap 4:
	- Bevestig met 
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D. LINKS
Deze functie maakt het mogelijk om gegevens met tussentijd door te sturen tussen groepen.

De Links zijn onderverdeeld in 3 delen:
Scene Link: door een scene te triggeren wordt een andere scene mee geactiveerd
Block Link: door het triggeren van één van de scenes in een block activeert deze dezelfde scene in een ander 
block en Group
Group Link: Zet scenes van de ene Group over naar de andere Group. Dimwaardes, en lichtwaardes worden 
niet doorgezet

Stap 1:
	- Voeg in het tabblad Routing Entries een Link toe 

	 Rechtermuis > Insert

Stap 2:
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te 	

	 maken
	- Geef een duidelijke naam op, beginnende met SL, BL of GL wat voor Scene, Block of Group Link staat

Stap 3:
	- Geef een tijd aan bij Link Duration. Dit is de tijd hoelang de action uitgevoerd zal worden na de trigger
	- Pas eventueel de Fadetijd hierbij ook aan

Stap 4:
	- Vul bij de Trigger Group, Block en Scene in waardoor deze link getriggerd/aangeroepen wordt

Stap 5:
	- Vul bij de Action de Group, Block en Scene in welke actie uitgevoerd mag worden na het verstrijken van de 	

	 Link Duration Time

Stap 6:
	- Bevestig met 

Link type: als deze op complex staat zal de action altijd uitgevoerd worden. Wanneer deze op simple gezet 
wordt kan deze link doorbroken worden door in dezelfde trigger groep een andere scene op te roepen.
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E. PRESENCE DETECTION
Deze functie verwerkt de info van bewegingssensoren.

Stap 1:
	- Voeg in het tabblad Routing Entries een Presence Detection toe 	

	 Rechtermuis > Insert

Stap 2:
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op 	

	 Properties om de instellingen zichtbaar te maken
	- Geef een duidelijke naam op, beginnende met PD wat voor 		

	 Presence Detection staat
	- Kies de Group met verlichting die geschakeld moet worden 
	- Kies Fixed or Constant Light

	- Fixed is zonder daglichtregeling
	- Constant Light is met daglichtregeling

	- Stel de juiste Timeouts in
	- On time = tijd dat de verlichting aan gaat bij beweging
	- Transition time = tijd dat de verlichting in dimstand blijft staan
	- Exit Delay = tijd van uitschakelen sensor door bediening met 	

	 schakelaar

	- Pas eventueel de Fade Times aan
	- Presence Checking from OFF = bewegingsdetectie
	- Absence Checking from ON = afwezigheidsdetectie
	- Bij de vinkjes zijn scenes te kiezen waarop de sensor eventueel niet afwezigheid hoeft te detecteren

Stap 3:
	- Selecteer de juiste sensor in het Device scherm
	- Geef in het Properties scherm dezelfde groep in als de verlichting en de Presence 	

	 Detection die zojuist gemaakt zijn

Stap 4:
	- Test de werking van de sensor door dubbel te klikken op de sensor en de symbolen in de pop-ups

Sensor in rust                        Sensor in On-time                 Sensor in Transition Time    Sensor in Exit Delay

In testmode wordt de timer op 15 sec gezet. Vergeet deze niet uit 
te zetten na het testen!

Kijk bij het testen 
altijd of je live bent!
 

Presence Checking from OFF en Absence Checking from ON staan standaard op Always. Onder Always 
kan er ook gekozen worden voor Never, of een conditie kiezen die in hoofdstuk 9 beschreven staat.



Helvar | Lighting Controls B.V.
Handleiding Designer software 23

F. CORRIDOR HOLD
Met deze functie is het mogelijk een functie te creëren waarbij de gangzone aan blijft zolang één van de 
aangrenzende kantoren bezet zijn. Na verlaten van het laatste kantoor zal de gangzone ook uitgaan.

Stap 1:
	- Voeg in het tabblad Routing Entries een Corridor Hold toe  

	 Rechtermuis > Insert

Stap 2:
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te 	

	 maken
	- Geef een duidelijke naam op, beginnende met CH wat voor Corridor Hold staat

Stap 3: 
	- Voeg bij de Routing Entry Trigger het groepsnummer in van één van 	

	 de kantoren 

Stap 4:
	- Voeg bij de Routing Entry Action het groepsnummer in van de gang

Stap 5:
	- Herhaal tot alle kantoren aan de betreffende gang een Corridor Hold hebben

Stap 6:
	- Zorg ervoor dat alle zones, zowel kantoren als de gangzone, een Presence Detection hebben
	- Hierbij is het noodzakelijk dat de On Time van de gangzone hetzelfde of langer is als van de kantoren
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G. CONSTANT LIGHT
Een Constant Light Routing Entry zorgt voor een constante lichtoutput van een groep. Dit is een 
daglichtregeling. Een Helvar sensor die beschikt over deze daglichtmeter zorgt ervoor dat wanneer het 
binnenvallend zonlicht sterker wordt, deze functie het licht laat dimmen. Wanneer het lichtniveau daalt zal 
de functie automatisch de lichten sterker laten branden. Een vereiste voor deze functie is dat de sensor zich 
in dezelfde ruimte als de armaturen bevindt. Standaard is deze functie in de sensor uitgeschakeld. Er kan 
zich ook maar 1 daglicht sensor in één groep bevinden. In onderstaand conversie-tabel kan u een schatting 
vinden van de lux waarden en Designer lichtwaardes.

Lux waarde (lux) Light Level Output Value Vergelijkbaar met

<1

2 11

5 26

10 38 Schemering

20 48

50 65

100 76 Donkere dag

200 87

500 102

1.000 114 Bewolkt zonnig

2.000 125

5.000 140

10.000 152 Daglicht

20.000 163

50.000 178

100.000 190 Zonnige zomerdag

In het onderstaande voorbeeld zullen we de meest gebruikte Constant Lights uitleggen.

Stap 1:
	- Voeg in het tabblad Routing Entries een Constant Light toe 

	 Rechtermuis > Insert > Constant Light > Constant Light
	- Kies voor een Constant Light in combinatie met een binnen sensor geplaatst in de ruimte bij de aan te 	

	 passen verlichting
	- Kies voor een Open Loop Constant Light in combinatie met de 329 Buitensensor, waarbij er bij diverse 	

	 zonlichtwaardes er een aantal % in verlichting binnen aangepast kan worden
	- Kies voor Open Loop Constant Light in combinatie met de 329 Buitensensor, waarbij er bij diverse 		

	 zonlichtwaardes een scene opgeroepen kan worden. Deze optie wordt veel gebruikt voor 			 
	 buitenverlichting
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Stap 2:
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te 	

	 maken
	- Geef een duidelijke naam op, beginnende met CL wat voor Constant Light staat

Stap 3: 
	- Vul bij Light Sensor de groep in waar de sensor in staat

Stap 4:
	- Vul bij Controlled Group het groepsnummer in van de verlichting die gedimd moet worden. Dit kan 		

	 de gehele ruimte zijn, vul dan hetzelfde groepsnummer in als hierboven. Dit kan ook een ander 		
	 groepsnummer zijn van bijvoorbeeld alleen de armaturen aan de raamzijde

Stap 5:
	- De default waardes van Scaling en Response rates zijn goed, door deze aan te passen kan de verlichting 	

	 sneller/trager dimmen 
	- Dead Band zorgt ervoor dat de verlichting niet bij elke wijziging al reageert, maar pas als het 4 levels 		

	 afwijkt

Stap 6:
	- Vul bij de Target Levels de waardes in per scene

Hoe in te stellen?

Stap 7:
	- Dim de verlichting totdat de gevraagde Luxwaarde bereikt is, bijvoorbeeld 500Lx 

Stap 8:
	- Lees in de Constant Light Entry bij Current Light Level de gemeten waarde uit en stel deze in bij Target 		

	 Level
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H. LIGHT OVER TIME
Met deze Routing Entry is het mogelijk om de verlichting op basis van tijd van kleur en/of intensiteit te wijzigen. 
Hiervoor dient wel Dali Type 8 verlichting gebruikt te worden.
Het is ook mogelijk om alleen de intensiteit aan te passen. Hiervoor is Dali Type 8 verlichting niet noodzakelijk.
 

Stap 1:
	- Voeg in het tabblad Routing Entries een Light over Time toe  

	 Rechtermuis > Insert

Stap 2:
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te 	

	 maken
	- Geef een duidelijke naam op, beginnende met LoT wat voor Light over Time staat

Stap 3: 
	- ‘Called at power up’ kan aangezet worden zodat deze Entry altijd geactiveerd wordt als er een router 		

	 herstart

Stap 4: 
	- Vul bij de Routing Entry Trigger de groep in waardoor deze Light over Time aangestuurd wordt
	- De Light over Time is geactiveerd als de Trigger Group in scene 1 t/m 12 is.  Als de Trigger Group in Scene 	

	 13 t/m 16 is wordt de Light over Time inactive

Stap 5:
	- Vul bij de Controlled Group de groep in die aangestuurd moet worden

Stap 6:
	- Kies onder Settings de Mode 

	- Clock Time: bij het triggeren gaat de verlichting naar de ingestelde waarde die op dit tijdstip is ingesteld
	- Triggered: bij het triggeren gaat de verlichting naar de ingestelde waarde van 00:00 en begint vanuit dit 		

	 punt met zijn Cyclus
	- Activeer Repeat om vanuit 23:59 weer door te gaan naar 00:00
	- Activeer Test Mode om de cyclus versneld af te laten lopen. Vergeet deze niet uit te zetten na het testen!
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Stap 7:
	- Dubbelklik op de Light over Time in het Routing Entries scherm om de instelling aan te passen. Hier kun 	

	 je de type Light over Time kiezen. Bijvoorbeeld één van de presets. Ook het laden van een 			 
	 eerder opgeslagen Light over Time cyclus is mogelijk.

Stap 8:
	- Houd Ctrl ingedrukt en druk in het schema op een willekeurige plaats om een punt toe te voegen. De 		

	 punten die toegevoegd worden bepalen de intensiteit van de verlichting
	- Zet met de pijltjes toetsen de punten goed

Stap 9:
	- Klik op een punt om de lichtkleur aan te passen
	- Klik aan de rechterkant op één van de tabbladen of klik op  als de tabbladen niet zichtbaar zijn
	- Klik op de punaise om het venster vast te zetten
	- Kies hier de gewenste kleur voor het geselecteerde punt

 

Stap 10:
	- Bevestig met 

Als de Light Over Time aan staat zal er een verticale gele lijn zichtbaar worden op de huidige tijd.
Ook in het Routing Entries scherm is de State zichtbaar. Hieraan is te zien of hij actief is en wat de laatst 
gestuurde waarde is. Als de Light Over Time inactief is zal er Inactive staan.
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I. SCENE TRIGGERED ETHERNET OUTPUT
Via deze Entry kunnen we door het triggeren van een scene een commando via ethernet versturen. Dit kan naar 
een Router in een andere workgroup zijn, maar ook naar een AV-partij om bijvoorbeeld de beamer/tv schermen 
aan te sturen.

Stap 1:
- Voeg in het tabblad Routing Entries een Scene Triggered Ethernet Output toe
 Rechtermuis > Insert

Stap 2:
- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te  
 maken 
- Geef een duidelijke naam op, beginnende met STEO wat voor Scene Triggered Ethernet Output staat

Stap 3: 
- Vul bij de Routing Entry Trigger de groep, block en scene in waarop getriggerd moet worden

Stap 4:
- Vul bij Ethernet Output de gewenste gegevens in. 
- Vul bij Transmission Router de router in waar de groep van de trigger in zit. Dit beperkt onnodige   
 communicatie tussen de routers

Stap 5:
- Bevestig met 

De standaard instellingen m.b.t. HelvarNet voor de communicatie tussen verschillende workgroups. TCP 
poort 50001. (Voor de ascii commando’s die verstuurd kunnen worden kan je de help file raadplegen -> 
control of query commands).
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Condities laten ons toe om de functionaliteit van alle bedieningen en routing entries verder te specificeren als 
dit nodig is. Een conditie/ voorwaarde gaat altijd uit van het principe dat er iets WEL uitgevoerd mag worden, als 
alle voorwaarde(n) dus waar zijn zal de actie waar deze conditie aan gekoppeld is gewoon uitgevoerd worden.

A. CONDITIE AANMAKEN
Stap 1:
	- Open het tabblad Conditions, dit tabblad is te open via View > Conditions, of via 

Stap 2:
	- Rechtermuisklik op Conditions > Insert > Hier heeft u de keuze uit de volgende 					  

	 vergelijkingsmogelijkheden: AND – OR – NAND – NOR. Dit heeft betrekking op de onderliggende 		
	 voorwaardes en wat de status van de aantal is uit te breiden naar 32 voorwaardes per conditie.

   

Stap 3:
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te 	

	 maken
	- Geef een duidelijke naam op. Deze benaming wordt in het selectie scherm zichtbaar
	- Bij Condition Logic is het type AND – OR – NAND – NOR nog aan te passen

9. CONDITIONS

‘Is Met’ in de properties geeft aan of de conditie op dat moment waar of onwaar is. 
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B. VOORWAARDE TOEVOEGEN
Stap 1:
	- Rechtermuisklik op de Condition > Insert > maak hier de 	

	 keuze voor het type voorwaarde wat toegevoegd moet worden.

Time range: wanneer de actuele tijd zich tussen de twee punten 
bevindt zal de voorwaarde True zijn. Deze punten kunnen vaste 
tijdstippen zijn zoals 8h30 maar kunnen ook bepaald worden via 
de astronomische klok met eventueel een offset. Bijvoorbeeld 
“Sunrise + 30 minuten”.
Days of the Week: dagen van de week kunnen geselecteerd worden waarop de voorwaarde True is.
Day and Month: jaarlijks terugkerende vaste dag.
Annual Date Range: jaarlijks terugkerende periode.
Date Range: eenmalige periode van dagen.
Analogue Input: wanneer u gebruikt maakt van de 942 input module kan u hier refereren naar de input 
source van de benodigde analoge ingang (0-10V). Hierdoor zal deze ingang iedere 5 seconden gemonitord 
worden. De analogue value geeft u een percentage terug. Als dit percentage zich binnen de input range 
bevindt zal de voorwaarde waar zijn. Voor meer info omtrent de input source verwijzen wij u graag door naar 
de help file.
Switch Input: deze voorwaarde kan ook aan een input source gekoppeld worden maar geeft geen 
percentages terug. Dit is een 1 op 1 koppeling met de aangesloten ingang en kan enkel gebruikt worden met 
binaire ingangen.
Condition Reference: u kan refereren naar een andere conditie. Op deze manier kan u bijvoorbeeld eenmalig 
een tijdsconditie aanmaken en deze telkens refereren wanneer deze nodig is. Bij een eventuele latere 
aanpassing hoeft u dan slechts eenmaal de tijd aan te passen.
Last Scene In Block: via deze voorwaarde kan u afhankelijk van de laatste gevraagde scene in een groep 
keuzemogelijkheden inbouwen. Let hierbij wel op met eventuele combinaties van een presence detection.
Light Level: afhankelijk van de gemeten lichtwaarde is de voorwaarde waar of niet.

Stap 2:
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te 	

	 maken
	- Geef eventueel een benaming,
	- Invert geeft de mogelijk om de voorwaarde om te draaien

‘Is Met’ in de properties geeft aan of de conditie op dat moment waar of onwaar is. 
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C. CONDITIES KOPPELEN
Waar kunnen Conditions toegepast worden? Dit kan bij iedere routing entry, maar ook bij individuele 
bedieningsknoppen. Enkele voorbeelden hiervan zijn:
	- Routing entries:

	- Detectie van de sensoren mag enkel tijdens kantoor uren werken en niet in de nacht.
	- In een ziekenhuis mag de verlichting niet uitgestuurd worden als de noodschakelaar in de verpleegpost 	

	 is ingeschakeld.
	- Wanneer een weerstation regen detecteert mag de zonnewering niet actief zijn.

	- Bedieningen:
	- Afhankelijk van een ‘Master’ schakelaar mogen bepaalde verlichtingszones niet uitgeschakeld worden.
	- Handbediening voor de zonwering moet geblokkeerd worden als de glazenwasschakelaar actief is.

Stap 1:
	- Open het onderdeel waarbij de conditie geactiveerd moet worden. Dit kan een bedieningselement, een 		

	 Routing Entry maar bijvoorbeeld ook een tijdsturing zijn.
	- Open de Properties

Stap 2:
	- Onder Condition/Main Set is nu naast Always/Never de aangemaakte conditie erbij gekomen.
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10. SCHEDULER

Via een scheduler kunnen we acties starten op bepaalde tijdstippen. Dit kan een vast tijdstip zijn maar ook 
een actie die afhankelijk is van de astronomische klok, eventueel met een offset hierop.

A. COÖRDINATEN INSTELLEN
Stap 1:
- Klik in het tabblad Devices met de rechtermuisknop op de Workgroup Name en open de Properties
- Pas hierin de Latitude en Longitude aan

Stap 2:
- Bevestig met 

B. SCHEDULED SCENE RECALL TOEVOEGEN
Stap 1:
- Open het tabblad Scheduler

Stap 2: 
- Voeg in het tabblad Scheduler een Scheduled Scene Recall toe
 Rechtermuisknop > Insert

Stap 3:
- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te  
 maken 
- Geef een duidelijke naam op, beginnende met SSR wat voor Scheduled Scene Recall staat

Stap 4:
- Kies bij Time Style voor een vaste kloktijd of voor Sunrise of Sunset met een eventuele offset 

Amsterdam: Latitude N 52°22’12” / Longitude E 4°53’42”
Brussel: Latitude N 50°51’1” / Longitude E 4°21’6”

De twee lichtgrijze regels staan er om de noodverlichting 'out of the box' al te laten testen, deze kunnen 
niet verwijderd worden
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Stap 5:
	- Vul onder Schedule Action in welke scene gestuurd moet worden.

Stap 6:
	- Bevestig met 

C. ZOMERTIJD EN WINTERTIJD INSTELLEN
Het systeem heeft geen vooraf ingestelde zomertijd en wintertijd schakeling, wel kunnen we deze zelf 
creëren. Dit doen we in onderstaande stappen, waarbij een aparte file gemaakt wordt zodat we deze in elk 
volgende project kunnen uploaden.

Stap 1:
	- Open het tabblad Scheduler

Stap 2: 
	- Voeg in het tabblad Scheduler een ‘Scheduled Daylight Saving Enable’ en een ‘Scheduled Daylight Saving 	

	 Disable’ toe 
	 Rechtermuis > Insert

Stap 3: 
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te 	

	 maken 
	- Noem de Scheduled Daylight Saving Disable ‘Wintertijd’
	- Noem de Scheduled Daylight Saving Enable ‘Zomertijd’

    

Stap 4:
	- Scheduled Daylight Savings Enable: 

	 Start zomertijd: om 2h00 op voorwaarde dat het een zondag is tussen 25 en 31 maart. De conditie dient u 	
	 zelf aan te maken. Wanneer u gebruikt maakt van scheduler moet u deze functie toevoegen.
	- Scheduled Daylight Savings Disable: 

	 Start wintertijd: om 3h00 op voorwaarde dat het een zondag is tussen 25 en 31 oktober. De conditie dient u 	
	 zelf aan te maken. Wanneer u gebruikt maakt van scheduler moet u deze functie toevoegen.

Stap 5:
	- Bevestig met 

De gemaakte condities en scheduler entries kunnen opgeslagen worden in een Designer file, zie hiervoor 
hoofdstuk 11A. Hoofdstuk 11B behandelt hoe de gemaakte offline file in een nieuwe installatie geüpload kan 
worden.
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D. DURATION TEST EN FUCTION TEST TOEVOEGEN
Noodverlichtingsarmaturen welke geschikt zijn voor DALI kunnen ook via de kalenderfunctie aangestuurd 
en getest worden. Hierbij moet wel rekening gehouden worden met de voorschreven testmomenten. De 
gemeten waarden zijn uit te lezen via het Emergency Report zoals omschreven in 3B.

Stap 1:
	- Open het tabblad Scheduler

Stap 2: 
	- Voeg in het tabblad Scheduler een ‘Scheduled Emergency Function Test’ en een ‘Scheduled Emergency 	

	 Duration Test’ toe 
	 Rechtermuis > Insert

 

Stap 3: 
	- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te 	

	 maken 
	- Geef een duidelijke naam aan beide regels

Stap 4:
	- Kies de tijd waarbij de test uitgevoerd moet worden

Stap 5:
	- Kies de groep met de noodverlichtingsarmaturen

Stap 6:
	- Maak een conditie aan voor beide regels. 

	 Voorbeeld: (Dit is puur een voorbeeld en niet gebaseerd op een eis of iets dergelijks)
	- Duration Test op 1 januari en 1 augustus
	- Function Test op elke 1e maandag van de maand, door middel van een Condition Reference

Stap 7:
-	 Bevestig met 
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E. TIME TRIGGERED ETHERNET OUTPUT
Via deze entry kunnen we op basis van tijd een commando via Ethernet versturen, dit kan naar een andere 
Helvar router in een andere workgroup zijn. Maar bijvoorbeeld ook naar een AV-partij om de beamer/tv 
schermen aan te sturen.v 

Stap 1:
- Voeg in het tabblad Scheduler een Time Triggered Ethernet Output toe
 Rechtermuis > Insert

Stap 2:
- Klik met de rechter muisknop op de toegevoegde regel. Klik op Properties om de instellingen zichtbaar te  
 maken 
- Geef een duidelijke naam op, beginnende met TTEO wat voor Time Triggered Ethernet Output staat

Stap 3: 
- Vul bij de Trigger Time de tijd in waarop de actie verstuurd moet worden 

Stap 4:
- Vul bij Ethernet Output de gewenste gegevens in. 
- Vul bij Transmission Router een willekeurige router uit het systeem in

Stap 5:
- Bevestig met 

De standaard instellingen m.b.t. HelvarNet voor de communicatie tussen verschillende workgroups. TCP 
poort 50001. (Voor de ascii commando’s die verstuurd kunnen worden kan je de help file raadplegen -> 
control of query commands).
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11. UPLOADEN BACK-UP

Elke wijziging die doorgevoerd wordt is live. Het is mogelijk om een systeem op te slaan, offline aan te passen 
en weer te uploaden in het online systeem. Het enige bezwaar is dat de adresvolgorde hetzelfde moet zijn.

A. BACK-UP OPSLAAN
Stap 1:
	- Sla het bestand op

B. UPLOADEN DESIGNER FILE
Stap 1:
	- Open het tabblad Upload,  dit kan ook via View > Upload of door op  te klikken

Stap 2:
	- Klik op  en selecteer het bestand

Stap 3:
	- Klik in beide schermen op de Workgroup name 

Stap 4:
	- Druk op  om de online file met de upload file te vergelijken

Stap 5:
-	 De schermen geven nu een aantal meldingen

In sommige gevallen is het mogelijk om alle routing entries vooraf al te maken. Voeg dan in de vooraf 
gecreëerde file één router toe, dit is noodzakelijk voor het uploaden. Pas hierbij ook stap 4 aan door niet 
op  maar op  te drukken, zo worden de systemen aan elkaar gekoppeld zonder dat er adressen 
beschikbaar zijn
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 Dit item komt niet overeen met het andere item.
 Gegevens kloppen niet, en zijn te uploaden

☺ Alle gegevens van dit onderdeel komen overeen
 Dit item is gelijkwaardig, niet alle instellingen zullen overgenomen worden
 Dit item is hetzelfde, alles wordt volledig overgenomen

Stap 6:
- Klik op een onderdeel en vervolgens op  om de onderdelen vanuit de upload toe te voegen aan de   
 online file

Stap 7:
- Klik als laatste, als alle onderdelen toegevoegd zijn op  om alle onderdelen die geüpload moeten   
 worden toe te voegen en klik in de pop-up op Upload

Stap 8: 
- Kijk of het groene balkje onder in het scherm volledig doorloopt. Bij mislukken van het upload proces is  
 niet alles geupload en zal het proces nog eens gedaan moeten worden

Stap 9: 
- Sluit het upload scherm

Stap 10:
- Klik met de rechter muisknop op de workgroup name > Logic > Add Logic, om alle gegevens in de juiste  
 routers te plaatsen. Mocht dit de eerste keer zijn en Logic niet beschikbaar zijn dan moet stap 11 t/m 12  
 opgevolgd worden

Stap 11: 
- Open de Options onder menubalk Tools

Stap 12: 
- Zet 'level of detail of groups menu' op  'All group Options'
- Zet 'allow logic housekeeping' op True
- Zet 'level of detail of Logic menu' op  'All logic operations'
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